What’s New In The 2000 CD
InfoBase

1. If you are a first time buyer of the CD InfoBase, please see the enclosed
1999 instruction manual. Installation is quick and easy. Here’s what’s new:
2. 1999 issues of HP Palmtop Paper can be found by clicking “The HP
Palmtop Paper” on the main menu.

3. 1999 ON DISK software descriptions and locations can be found by
clicking “HP Palmtop Paper ON DISK” on the main menu.

4. There is LOTS of new software and an in depth Lotus tutorial that you
can read about and find by clicking “Software Bonanza.”

5. A Web (HTML) version of 1991-1999 issues can be found on the main
CD InfoBase CD in subdirectory \ptphtml. To start load file
\ptphtmN\index.htm into your web browser. Note that 200LX web browser,
HV, can be found at \ONDISK\98-DISK\98MAYJUN\HV\HV .EXE

6. Year 2000 Gutenberg electronic books and documents are found in
\gutenbrg on the main CD. Previous years Gutenberg text is found on the
’99 Project Gutenberg Bonus CD. For a listing of books and documents
click on “Project Gutenberg E-text.”

7. If you are upgrading, you can run this version by inserting the main CD
and clicking on the existing icon. If you store CD InfoBase files on your
hard drive, copy the files from the \CD directory to the directory on your
hard drive where you store CD InfoBase files (probably C:\PTPBASE).

Deluxe

The HP Palmtop Paper’s  Edition

1999 D infoBase

= 49 issues of The HP Palmtop Paper (1991-1998) and Bonus Issues all in an easy to read
hypertext format.

= HP 100/200LX User’s Guide also in hypertext format.

o All the freeware and shareware from the 45 issues of The HP Palmtop Paper ON DISK and
Bonus issues plus all 5 PowerDisks (1991-1997).

= Complete MicroREF DOS and Lotus 1-2-3 manuals.

@ 100/200/700LX Developer’s Guide plus PAL and HP EXM Software.

NEW For 1999

& PC In Your Pocket: Information When You Need It—the complete text and pictures from
the Book now in HTML format. Read it on your Palmtop with Hypertext Viewer (HV).

i The Developer’s Guide now in HTML format so it can be read from your Palmtop.

= Software Bonanza: including several formerly commercial programs such as Lotus Agenda and
Magellan, WordPerfect’s DataPerfect, PC-File, Accounting Pro for DOS plus over 100 DOS
shareware and freeware programs that will let your Palmtop do everything from Palmtop
Publishing to Statistics to playing games.

BONUS CD

We have filled an entire CD with as many e-texts as possible by special arrangement with the
folks at Project Gutenberg. Copy to your Palmtop and view in Vertical Reader (VR100) or Memo.

Thaddeus Computing, 110 North Court, Fairfield, Iowa 52556
515-472-6330  800-373-6114  Fax: 515-472-1879




2-CD DELUXE EDITION

THE

HP Palmtop
Paper’s
CD InfoBase

The HP Palmtop Paper
and Bonus Issues in an
easy-reading hypertext
format

HP 200LX User’s Guide
(for 100/200LX users)

DOS and Lotus 1-2-3
MicroREF Manuals

All the freeware and shareware
from The HP Palmtop Paper
On Disk and Bonus Issues
plus PowerDisks

HP 100/200LX Developer’s
Guide plus PAL &
HP EXM Software

Over 1000 Project
Gutenberg E-Text files
ona BONUS CD



Notices:

The HP Palmtop Paper’s 1998 CD INFOBASE
Copyright © 1998 Thaddeus Computing, INC

110 North Court

Fairfield, Jowa 52556 USA

All rights reserved.
Neither this documentation nor the software may be copied, photocopied, repro-
duced, translated, or reduced to any electronic medium or machine-readable form

in whole or in part, without the prior written consent of Thaddeus Computing.
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Other products available from Thaddeus Computing

Thaddeus Computing provides a wide array of portable computing-related knowl-
edge products including The HP Palmtop Paper (print and disk versions), and
Handheld PC Magazine, serving Windows® CE-based handheld PC users.

In addition, Thaddeus Computing has introduced Thaddeus Palmtops! We sell
upgraded DoubleSpeed 8 Meg new and like-new palmtops; upgrade customer
palmtops to DoubleSpeed and 8 Meg; and sell an assortment of palmtop acces-
sories like cables, adaptors, PC cards and Connectivity Packs.

For more information about Thaddeus Computing products and services, please
write, fax, or call one of the numbers below.
800-373-6114

515-472-6330 Fax: 515-472-1879

Double-CD Deluxe Edition
The HP Palmtop Paper’s

1998 CD INFOBASE
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Note: The following convention is used throughout this document: Menu commands
are written in series separated by a pipe character “|”. For instance,
File|Preferences|Searches instructs the user to select File from the main menu;
Preferences from the pull-down menu that appears; and Searches from the next list of
options that appear.
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Installation

Installation of the CD InfoBase can be done automatically or manually.

NOTE: If you already have a previous version of the CD InfoBase installed,
you should be able to run this version from the existing icon. If that fails,
proceed with a complete installation.

Automatic Installation

1. From Windows, run DAINSTALL where D is the letter of your CD
drive (File]Run D:\INSTALL). This process will install about 1.5
megabytes of data to your local drive and create a program group in
Program Manager with the CD InfoBase icon in it.

2. Activate the CD InfoBase icon to run The HP Palmtop Paper's CD
InfoBase.

Manual Installation

Run Install as in item 1 above and follow the directions for a manual
installation. (Manual.txt contains these instructions and can be found in the
root directory of the CD, and in C:\PTPBASE after automatic installation.)
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Navigating

Overview of CD InfoBase Layout

Here are a few concepts about the design and layout of the CD InfoBase that
you should be familiar with:

Topics

Topics are the main building blocks of the CD InfoBase. A topic is a
subsection of a document (i.e., The HP Palmtop Paper May/June 1993). It
may be as short as a single Quick Tip in a Palmtop Paper, or as long as an
entire chapter in the HP 200LX User's Guide. No matter where you are in
HyperReader! (the program the CD InfoBase uses), you are in a topic.

Generally, the Table of Contents for any given document is the first topic.
You may move forward or backward sequentially through topics using the
[Next] and [Prev] icons. If you know a specific topic's Topic Number (the
Current Topic Number is found by selecting Navigate|Goto... from within
that topic), you may go directly to it using the Goto... command in the
Navigate menu.

Topic Numbers also play a role in printing. (See Printing)

Documents

The idea of Documents can be a little confusing in the CD InfoBase because
the term refers to two different concepts.
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1. Document As File: In the CD InfoBase, every file that you can open and
view in HyperReader! is a document. For instance, each individual issue of
The HP Palmtop Paper is a document. The specific title of the document you
are currently in (i.e., May/June 1994) appears at the very top of the screen.

Note: In The HP 100/200LX Developer's Guide, every chapter is a
document (separate file) whereas the entire HP 200LX User's Guide is one
single document (file).

2. Document As File Group: This pertains to the Find functions. When you
open the Find dialog box by clicking the Find icon, pressing Ctrl-F, or
choosing Find from the Search menu, you will see a Document box with all
items checked. These "Documents" do not refer to individual documents as
described above, but rather, groups of documents combined by category. For
instance, PTP95 refers to all 1995 issues of The HP Palmtop Paper. The
Find dialog box is the only place where Documents are combined into
groups.
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Getting Around

There are many ways to navigate in HyperReader!. Briefly, they include:

Following Hotlinks:

Any word or title enclosed in half diamonds are links that will take you to the
area indicated by the text. You may click on them or situate the cursor
between them and press Enter or F1.

Full diamonds appear at the top of The HP Palmtop Paper On Disk Tables
of Content, and will return you to the Table of Content for that particular
printed issue.
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* The text between half diamonds is "hot"'.

Other hotlinks include icons and buttons like the six large blue buttons at the
bottom of the opening screen.
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[Next] & [Prev] Icons

These will take you forward or backward sequentially through the topics of a
document. If the [Prev] icon fails, press Alt-r and try again.

[Contents] Icon & HOME Button

The [Contents] icon will always take you back to the first topic in the
document you are currently in, generally the Table of Contents for that
document.

The HOME button will take you back to the Opening Screen.

[Bookmark] Icon

You may leave bookmarks anywhere in the CD InfoBase to allow speedy
return.

[Find] Icon

Find is one of the most powerful functions of HyperReader!. After clicking
on the [Find] icon (or choosing Find on the Search menu, or pressing Ctrl-
F) you will see a dialog box with an area for typing in your search query (see
figure 1 below). When you have typed in the word or phrase you would like
to search for, click on Find or press Enter.
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The next box you see is a list of Search Occurrences (see figure 2 above).
Each listing is the name of the topic in which an occurrence appears, (as
shown below; Reviews: IC Cards) the general category of publication in
which it appears (PTP93 refers to an issue of The HP Palmtop Paper from
1993) and the number of occurrences in that topic (2).
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Reviews: IC Cards [PTP93] [2]

This list of occurrences is designed to help you further narrow your search.
You may double-click on an item to go to it, or simply highlight it and press
Enter. This will take you to the actual occurrence (see figure 3 above).

Once you have gone to the location of a Search Occurrence, you may travel
forward or backward through the list of occurrences, without returning to the
Search Occurrences box, by clicking on the [Search>>] or [Search<<] icons.
You may see the list of occurrences again by clicking on the [Hits] icon.

Whenever you go to the Find dialog box, you may click the down-arrow (to
the right of the Search For: box) to see a list of previous search queries from
which you may choose. (Search queries are saved in the HRW.INI file in
C:\PTPBASE.)

You may also narrow your search by unchecking documents in which you are
not interested. If you're looking for a reference you remember from a 1994 or
1995 issue of The HP Palmtop Paper, you may uncheck all but PTP94 and
PTP95 to speed the search and avoid irrelevant Hits. (By default, all items
are checked every time you open the Find dialog box. The default cannot be
changed.)

Also appearing in the Find dialog box is a list of Boolean search operators
from which you may choose. For more information on using Boolean search,
see the "Boolean Search Instructions” under "Other" in the Main Table of
Contents (accessed by clicking the [Contents] icon from the Opening
Screens).
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Further Search options are available by changing the settings in
File|Preferences|Searches. More information on Find is available in the on-
line Help feature.

Escape & Right Mouse

Escape and Right Mouse are the same. They allow you to back up along your
own trail.

[History] Icon

Clicking on the [History) icon will display a box showing where you've been
and how long you've been there. You may return directly to any of these
locations by double-clicking on its listing or by highlighting it and pressing
Enter.

Other Features

Export Text (Ctrl-E)

To export the text of an article in The HP Palmtop Paper (or any other topict
in the CD InfoBase) to an ASCII file on a disk drive on your PC, choose
File|Export Text. You will then be asked to provide a name for the file, as
well as a location for the file to be written to. You may choose Options from
the Export Filename dialog box, such as Send Hard Returns, use
WordPerfect formatting, or apply header info.



10

THE HP PALMTOP PAPER'S CD INFOBASE

Text is exported from one topic at a time. If you would like to save multiple
topics to the same file, select the same filename as the first when exporting
subsequent topics, and select Append.

If you don't wish to export the text from the entire topic, simply highlight the
portion of text you wish to export and perform the same Export Text
procedure as above.

Copy & Paste

Another option for capturing text from the CD InfoBase is to simply Copy &
Paste using normal Windows conventions.

1.

Print

Highlight the text you want to Copy using either the mouse or keyboard
commands.

Press Ctrl-C or choose Copy from the Edit menu.

To copy additional text to the text you've already copied to the
Clipboard, you can use the Append w/Copy (Ctrl-F7) command.

Once you have compiled the text you want into the Clipboard, you can
enter a word processing program and use Paste (Ctrl-V in Windows
programs) to insert the text.

There are two ways of printing:
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1. Use the [Print] icon to print the current topic.
Or

2. Use File|Print if you want to select a group of topics to print together.
You may also print a series of topics by entering the correct topic
numbers in the Print dialog box. The first topic number that appears is
that of the topic you are currently in. To determine the topic number of
the last topic in the series you wish to print, go to that topic and find the
Current Topic Number by selecting Goto... from the Navigate menu.
Then cancel and return to the first topic in the series you wish to print,
select Print from the File menu, and enter the topic number of the last
topic to print in the To: box.

Also, the Print command under the File menu allows you to highlight
specific paragraphs and print them separately. Any paragraph that is
highlighted even partially will print in its entirety. (The [Print] icon will
print the entire topic, not just highlighted text.)
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Also on the CD

Graphics

Graphic links appear throughout the CD InfoBase. They are usually red text
between half diamonds. Occasionally you will also see large or complex
tables as graphics. All of the graphics are scanned at screen resolution of
75dpi so that all users will be able to use them. Unfortunately, that means that
the graphics are not always as crisp as could be desired.

‘Before You Begin T nd fou Bogin. o baserf
| ot anai ut e Topecord o5 descrved ot e bogmung of e QuckSiart dsto. and il ot o Topcard s oo
Gudo Gude

Instal tho bae

A Look at Your Palmtop PC A Look at Your Paimtop

AGraphich

Hardware Features
Amony

s the keyboard end dspley

8 "z00m" copabittyfor

Screen #ith graphic link.

Graphic link activated.

If a graphic appears with scroll bars along the bottom and right side, you may
use these to move around in the image. Images with scroll bars can also be
zoomed in on by using your left mouse button to draw a square around the
area you wish to zoom. Graphics without scroll bars cannot be zoomed.
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Software/Freeware/Shareware

All the software from The HP Palmtop Paper On Disk 1991-1997, as well as
the Power Disks, the Best Tips disks, the PAL software (Palmtop
Applications Library v 1.6), and the HPEXMTLS software is provided on
the CD. Most of these have Tables of Contents complete with brief abstracts
about the software for you to peruse. For instance, The HP Palmtop Paper
On Disk November/December 1997 Table of Contents can be accessed from
the Table of Contents for the printed version of that issue.

All software has been decompressed. All decompressed programs are in
subdirectories named for the programs. These subdirectories, in turn, are in
subdirectories named for the specific issue in which they appear. For
instance, the program Remkey, originally provided on The HP Palmtop
Paper On Disk Jan/Feb 1994, would be found at D:\ONDISK\94-
DISK\94JANFEB\REMKEY\* *, where D is the drive letter of your CD
drive.

You may copy files to your hard drive using Windows File Manager or the
DOS copy command. In File Manager, highlight the files you just transferred
and go to File|Properties to turn off the read-only attribute.

Some items, like the PAL software, are broken down into further
subdirectories.

Shareware programs are provided for you to use on a trial basis. If you like a
shareware program and decide to use it, you are required to pay the author of



THE HP PALMTOP PAPER'S CD INFOBASE

the program a shareware fee. The specifics of each shareware agreement are
included in each shareware program subdirectory.

BONUS CD: Project Gutenberg E-Text Files

We have included over 1,000 e-text files on the Bonus CD. These are public
domain items (no copyright or copyright expired) such as The Wizard of Oz,
and documents such as the NAFTA treaty.

These can be found in subdirectories of the Bonus CD. Each subdirectory has
an index of contents that you can view in a word processer (*.txt) or web
browser (*.htm) on your PC.

You can download files to your palmtop for viewing in Vertical Reader (on
the Bonus CD), Memo, or other word processing program, or print them or
read them on your PC.

NOTE: If you wish to view these files by double-clicking on them from
Windows in File Manager, you may have to choose Associate under the File
menu and change the program Windows uses for text (*.txt) files to Write or
some other word processor. The default setting is Notepad, which is unable to
handle files larger than approximately 50k.
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Troubleshooting

Many minor problems can be easily fixed by closing unnecessary
applications to allow HyperReader! more room to operate. Exiting and re-
entering the program may also help in certain situations.

If you have changed configuration settings and are unable to reset them
properly, simply reinstall the program, choosing the installation option to
Install All Files. If this fails, delete the entire C:\PTPBASE directory and all
of its contents from File Manager, and then reinstall.

Work-around if automated installation fails

1. Make a directory on your hard drive called PTPBASE, i.e.,
C:\PTPBASE.

2. InDOS, File Manager or Explorer, copy all files from the root directory
of the CD into the newly created PTPBASE directory. There should be
27.

3. Run the file HRW.EXE from the PTPBASE directory. When the
program runs, you will see a blank screen.

4. Click on the File menu. Choose Preferences., then Directories.

5. Change the first three directory options (Documents, Pictures and Text
Files) to D:\CD (where D is the letter of your CD-ROM drive).

6. Change the fourth directory (Local Files) to C:\PTPBASE (or whatever
drive and directory you used in Step 1 above).
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7. Click on OK. Exit the program. Restart the program. It should now run
normally.

Blurred or distorted text on screen or [PREV] Icon doesn’t work.
Redraw Screen

Use alt-R to redraw the screen.

More Info

On-line Help is always available by clicking the [Help] icon or choosing one
of the Help commands under the Help menu.

A link to Boolean Search Instructions can be found by clicking "Other" in
the Main Table of Contents.

The fastest, most enjoyable way to become familiar and fluent with the CD
InfoBase is to use it. Explore the Menu functions and the icons to see what
functions are available and how they work. HyperReader! is a rich and
powerful program that is both flexible and exceedingly user-friendly.

Enjoy!
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2-CD Deluxe Edition

42 issues of The HP Palmtop Paper and Bonus Issues in an
easy-reading hypertext format (1991-97)

HP 200LX User’s Guide (for 100/200LX users)

All the freeware and shareware from 39 issues of The HP Palmtop
Paper On Disk and Bonus Issues plus all 5 PowerDisks (1991-97)

Complete MicroREF DOS and 1-2-3 manuals
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Detailed Advertiser Information

PLUS: BONUS CD!

We also included over 1000 e-text books and documents

ranging from Cicero’s Orations to Clinton’s inaugural address, from
Black Beauty to Dracula. All ready for you to download to your Palmtop
(read in Vertical Reader [VR100] or Memo) or PC and read or print.
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